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S0, What 1s DeskMate Anyway?

DeskMate is what programmers like to call a graphical interface.
That means a visual, simple, and intuitive way to work with your
computer. DeskMate is software that creates a friendly
graphics-oriented environment where you can see exactly what
your choices are, and pick them right from the screen.

People buy computers with various uses in mind. Some want to
write letters or reports. Others want to keep budgets, communicate
with other computers, keep records, or sometimes just play games.
DeskMate comes with a large collection of easy-to-use programs
that can perform these functions and many more.

Because these programs were specially designed to work in the
DeskMate environment, once you are familar with DeskMate, you
can easily operate any of the programs. You can also run most
other standard programs from your DeskMate desktop. In addition,
DeskMate's environment lets you exchange information and images
between programs quickly and easily.

This guide is made up of short articles on how to use DeskMate and
all its programs. These articles contain examples of some of the
exciting ways you can use your computer with DeskMate. If you
need more information about a particular function, you can look it
up quickly in the DeskMate User’s Reference.

Computing has never been easier or more fun. So, let's get started!
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Starting DeskMate
with a Tandy1000 SL
or a Tandy 1000 TL Computer

1. Be sure your computer is connected
as described in First Things First.

2. Turn on the monitor.
3. Turn on the computer.

DeskMate's central screen, the desktop,
appears immediately.

If you exit DeskMate and see the A> prompt, or if
you change your Tandy 1000 SL or 1000 TL
computer’s settings so that DeskMate no longer
starts automatically, simply press F12 at the system
prompt (A>). DeskMate appears.

Starting DeskMate on Other
Diskette-Based Computers

1. Start your computer as you normally
would.

2. Put the Desk.exe diskette (Diskette 1)
in Drive A.

3. [fthe screen prompt is not A>, type:
a:
Then, press ENTER.
4. Atthe A> prompt, type:

desk

Then, press ENTER.

5. If you see a message asking if this is
the first time you have run DeskMate,
simply press ENTER.

6. Then, if you see another message
telling you to insert the diskette that
will contain the configuration file,
press ENTER again.

Information your particular computer
will need each time you start
DeskMate is now on your Desk.exe
diskette.

DeskMate's central screen, the deskiop,
appears.




Installing and Starting DeskMate
on a Hard-Disk System

1.

2

Start your computer with the hard
disk.

Create a directory for DeskMate by
typing the following at the system
prompt (C>):

mkdir \desk

Then, press ENTER.
When the system prompt returns,
change to the DeskMate directory by
typing:

cd \desk
Then, press ENTER.
Insert one of the DeskMate diskettes
in Drive A, close the latch (if
necessary), and type:

copy a:*.*
Then, press ENTER.

When the system prompt returns,
replace the first DeskMate diskette
with a second diskette. Repeat the
command in the previous step with
each DeskMate diskette to copy all
the DeskMate files to your hard disk.
You are now ready to start DeskMate.

To start the program, type:
desk
Then, press ENTER.

DeskMate's central screen, the desktop,
appears.

Exiting DeskMate

Be sure that the desktop is displayed.
Then, press Esc. The desktop
disappears, and the system prompt
appears.

If you see a screen message asking for
the diskette containing Command.com,
insert your MS-DOS diskette and press

ENTER. Your system prompt now appears

on the screen.




The Desktop

To show you just how easy computing
can be, we'd like you to take a tour with
us—a tour through DeskMate.

As soon as you start DeskMate, the
desktop appears on the screen.
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Unless you are running DeskMate from a
hard-disk system, there is a basic
principle you need to keep in mind. You
must put the diskette that has the
program you want to use into the drive to
be able to use that program. The thing to
remember is, each time you change
diskettes you need to update your
screen so that you can see the programs
available on the new diskette. If you are
running DeskMate from diskettes, follow
these instructions.

1. Find the diskette that has Text on the
label.

2. Insert it into the drive, label side up,
until the diskette clicks into place.

3%" Diskette (Label up)

3. If you have a latch on your drive,
close it.

4. Press the F2 key. This key opens the
File Menu.

5. To select the update option, press the
| key until you highlight Update
screen. Then, press ENTER.

Your desktop now reveals the programs
that are available on that diskette. Notice
that there are now names of application
programs in the list boxes and that all the
programs on this diskette are listed in the
Programs list box.

You've already learned a lot about
operating DeskMate. You've opened a
menu and selected an option. You'll find
menus and options work this way
throughout DeskMate. The following
illustrates the most important keys for
getting around on the desktop.

Press 1aB to move the highlight to the application

you want to open.

Getting Around the Desktop

Press the appropriate F key to open a menu and see the

menu options.

Press the appropriate arrow key to move the

highlight to the menu option or file you want to

select.
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Text

One of the most popular DeskMate
applications is Text. Using Text, you can
write a letter, a report, or even a book.

Let's take a look at the Text screen. To
open the Text application:

1. Press 1aB until you highlight Text.
2. Then, press ENTER.

That’s all you have to do. The desktop
disappears and the Text screen appears.

Jul 18, 1988 1. 44 pn Text - (Untitled)
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You can start any DeskMate application
from a list box this easily.

Notice that many elements of the Text
screen are similar to the desktop screen
that you just left. That's one of the great
things about DeskMate—learning to use
one option helps you use many others.

You can learn more about Text later, so
let’s exit Text and go back to the desktop.
Doing so is even easier than starting
Text—just press ESC.

Setup

Applications are the large programs in
DeskMate. DeskMate also has a
selection of smaller programs called
accessories.

Two of DeskMate’s accessories,
Calculator and Month, are graphically
represented on the screen. You can open
them in the same way you opened Text.

Besides Calculator and Month, DeskMate
has other accessories. The other
accessories are listed in DeskMate's
Accessories (F10) Menu. A menu is a list

of options. To view the accessories,
press F10. '
D¢

Setup

Spell Checker
Calculator
Phone List
Corkhoard
Honth
Cliphoard
Alarmn

Task Switch

To access a menu option, you first
highlight the option using the arrow keys.
You can move down with the | key or up
with the 1 key.

1. Highlight Setup by pressing the | key.
2. Then, press ENTER.

Setup is a multi-function accessory
that lets you change the way
DeskMate looks and works. For
instance, DeskMate displays its date
and time at the top left of the deskitop
screen. You can change this display
at any time using Setup.




Exiting a Dialog Box |

| | You can also press

| ENTER at any time to
'close a dialog box.
| Pressing ENTER is the
| same as selecting 0K
| and causes DeskMate
| to record any changes
| you have made.

6.
' Pressing esc in a dialog

box is the same as
‘ selecting CANCEL.

For example, if the date is September
5, 1988, you can type:

To select Date and Time, open the
Options Menu by pressing F2.

iy X ] 09051988
Highlight the Date and Time option. o
Then, press ENTER. 09 51988

Either way is correct.

A dialog box appears.

Press TAB to move to the Time:
prompt.

Set Date And Time £

1993 8. Change the time by typing a new one.

Separate the hour, minutes, and
seconds with colons. For instance:

02:12:30
O o

L0k QI CANCEL -

Again, either way is correct.
Displaying a dialog box is DeskMate’s
way of telling you it needs more
information. In this case, DeskMate
needs to know what date and time
you want to set.

9. Press TAB to move to the AM and PM
buttons.

10. Use either the — or — key to

underline the proper button.

11. Press the space bar to "push” the

Notice that the date (opposite the button.

Date: prompt) is already highlighted.
This means DeskMate is waiting for

12.
you to type a new date.

To tell DeskMate you want to use the
new date and time, press TAB until
you underline the 0K button, and
then press the space bar.
or

If you don't want to change the date

and time after all, press the — key

to underline CANCEL, and then press

the space bar.

Type the month, day, and year in the
appropriate blanks. The hyphens that
separate the month, day, and year
are automatic; so you don't type them.

TAB

Moves the cursor to

. the next choice. —

I SPACE I

Chooses a button or check |
box that the cursor is on.

Getting Around a Dialog Box

Wl DIALOG BC ; g
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iy
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e - the dialog. “ Pressmg this key is
Select this button to confirm ‘ — —
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Programs List Box

Not all of DeskMate'’s applications are
displayed in list boxes on the desktop.
You can make list boxes for them if you
want. In the meantime, you can select
any application from the Programs list
box.

See the Desktop chapter in your reference
manual for information on how to create list
boxes.

Let's use the Programs list box to open
Worksheet and take a peek. If you are
using diskettes, be sure the diskette
containing Worksheet is in the drive and
your screen is updated.

1. Use TAB to move the highlight to
PROGRAMS.

2. Press | until WRKSHEET.PDM is
highlighted. Moving through a list in
this way is called scrolling.

3. Press ENTER and the Worksheet
screen appears. Worksheet is a
spreadsheet application. You can
learn more about Worksheet in the
Worksheet article.

4. When you are ready to exit
Worksheet, simply press Esc, and
you return to the desktop.

Help
DeskMate’s
Quick Reference

Before you leave the DeskMate tour, we'd
like to show you one other feature,
DeskMate’s Quick Reference. To try it,
press Fi1.

DeskMate’s Quick Reference box
appears, listing the subjects for which
you can get help. From the desktop or
from any application, you can always get
help from the Quick Reference by
pressing F1.

All the listings don't fit on the screen at
the same time. So, use the | key to scroll
through the options one at a time. Use
PGDN and PGUP to scroll through the
options one page at a time.

Highlight any option you wish, then press
ENTER to read the information about it.
Some references have more information
than can fit on one reference page.
When this is the case, use PGDN and
PGUP to view other pages.

Some of the Quick References are on-line
tutorials.

If you select a tutorial, it will lead you
through exercises to teach you some of
DeskMate’s basic operations.

We encourage you to spend some time
with the Quick Reference. There is no
quicker way to learn the fundamentals of

DeskMate and get "hands-on" experience.

When you are through, use TAB to
choose CANCEL, and then press the space
bar. Or, you can close the Quick
Reference box at any time by pressing
ESC.

Swapping Diskettes

If you are running
DeskMate using disk-
ettes, only the
programs contained on
the diskette currently in
the drive will appear in
the Programs list box.,

If you have to swap
diskettes, be sure to
update the screen. To
do so, press F2 to open
the File Menu. Press the
| key to highlight
Update screen. Then,
press ENTER. Your
desktop now reflects
the programs that are
available.

1"
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Now What?

So far, you've seen only a small part of
DeskMate's capabilities, but you've
learned all the basics. The rest of this
guide shows you examples of what
DeskMate's programs can do.

If our tour was successful, you now want
to put DeskMate to work. You might want
to:

o Write letters and notes with Text

¢ Play a game of Hangman

» Keep track of your household inventory
with Filer

» Connect your computer to the phone
line and browse the latest movie

reviews or make your plane
reservations with PC-Link

o Draw illustrations or create your next
Christmas card with Draw

# Calculate your budget with Worksheet

T E

If you would like to get a better feel for all
of DeskMate, go ahead and explore.
Open other menus and applications. Try
some of their features. You cannot harm
your computer or its programs by
exploring and experimenting.

If you have a specific need for one or
more of DeskMate’s functions now, turn to
the articles of this guide that deal with
your interests.

Once you begin using DeskMate, it won't
be long before you need to do some
management tasks, such as copying
diskettes, duplicating files, and changing
directories. DeskMate’s menus—File,
Directory, Disk, View, Sort, and Desktop—
provide tools for these functions, and
more. In addition, DeskMate includes
tools that let you customize DeskMate
and your system to match your personal
likes and needs.

For a complete reference to any
DeskMate application or function, use the
DeskMate User's Reference.




WANT TO
_ TRY A MOUSE?

\

Your approach to handling DeskMate will
be from the keyboard, from the mouse, or
maybe from both. A mouse is a handy
piece of equipment to own. If you install a
mouse, you'll find that it speeds up your
work in DeskMate considerably.

Using a mouse with DeskMate makes
moving the cursor around on the screen
much faster and easier. The cursor is the
highlight you see on the desktop. In
different DeskMate programs, the cursor
takes different forms, but it always lets
you know what part of the screen you're
working with. Using a mouse, you can
move the cursor anywhere on the screen
simply by pointing, clicking, and dragging.

Y/

You can’t wait to learn how to point, click,
and drag? Then, read on to learn how to
set up your mouse, and you’ll be on your
way!
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Setting Up Your Mouse

Before you can use your mouse, you must connect it to your computer and set it up.
Refer to the manuals that came with your computer and mouse for installation details.
See "Of Mice and Modems" later in this guide for an overview of serial mouse installation

rules. DeskMate's Setup accessory helps you tell DeskMate all about the mouse you're
using.

1. From the desktop, press F1o0 to open the Accessory Menu.

2. Usethe | key to highlight Setup. Then, press ENTER.

The Setup screen appears.

3. Press F2 to open the Options Menu.

4. Usethe | key to highlight Mouse. Then, press ENTER.

A dialog box appears.

5. Use the arrow keys to underline the selection that matches the type
of mouse you have:

o If you have a joystick or a Tandy Color Mouse, underline Joystick.

e If you have a serial mouse, and you plan to use that mouse in DeskMate,
underline Serial mouse.

¢ If you have previously installed a Microsoﬁ®-compatib|e mouse driver to use
with other programs (and you want to use that driver in DeskMate), underline
Other mouse.

e If you don't have a mouse (or if you have a mouse, but you don’t want to use
it in DeskMate), underline None.

Then, press the space bar to make your choice.

6. If you chose Serial mouse, press TAB to move to the Serial mouse port: prompt,
and use the arrow keys to underline the correct port. Then, press the space bar to
make your choice. We recommend that you use COM1 for your serial mouse,
unless you have a modem. See "Of Mice and Modems" for more information.

If, after using DeskMate for awhile, you want to change the mouse's double-click speed, refer to the
Accessories chapter in your DeskMate User's Reference for complete information on how to experiment
with the choices in the Double Click Speed box. For now, skip the Double Click Speed box.

7. Use TAB to move to the 0K button. Check to be sure your choices are correct, and
then press ENTER.

See that arrow on your screen? That's your pointer. Your mouse is now ready to
use.

8. Press Esc to return to the desktop.




Point, Click, and Drag

Using a mouse really is as easy as
pointing, clicking, and dragging. The o=
following gives you the particulars.

Point

Move the mouse until the pointer is where
you want it.

Tre—eas,

Click ig

Quickly press and release the left mouse ! i

button. >__.-_K
i

moving the mouse.

‘ D Drag
—j]g—L——J—n Hold down the left mouse button while

Shift Click

Double Click
' Hold down the SHIFT key and click the left Click the left mouse button twice in rapid
‘ mouse button. succession.
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A
\ f You can say goodbye
: - to your typewriter and give
e yourletters, term papers, and
important documents a facelift
with DeskMate’s Text application.

ety

e IR 52 Use Text for any project forwhich

you would ordinarily use a

typewriter.

Whe_n you enter Text from the desktop for Think of the Text screen as a sheet of typing
thefirsttime, here's what you see: paper. Thedifference is—if you make a

o R TE e : mistake, you don't have torip out the paper
andthrow it away.

Simply use afew Text commands to adjust
yourdocument until it is exactly the way you
wantit. Text can even check your spelling.

This "just-for-fun” article explains some of
the basics of Text and then guides you
through some editing techniquesinafun
way. Ifyou haven'talready read'The
DeskMate Tour," do so now and familiarize
yourself with the moving around
techniques. Then, take afew minutestotry
some of the tasks inthis article. Enjoy!
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An eerie shadow looms over the computer—the blinking cursor on the computer screen How to Correct
is the only movement inthe room. Moments pass, andfinally the lone figure faces the Mistakes

screen and beginsto type the confession that (if discovered in time) will save Nellie’s life.
BACKSPACE deletes the

- i ter.

Type the followmg paragraph: previous character
DEL deletes the

To whom it may concern: (ENTER) chargcter at the cursor
position,

On the night of April 6, 1987, I committed (ENTER) Ay e
ow to Highlig

the act of murder against Floyd Fiend. (ENTER) a Block of Text
Keyboard
(TAB) Signed, (ENTER) y
1. Use the arrow keys
th
(TAB) Luke Ludicrous to move the cursor

to the beginning of

| the text you want
Luke studies the confession with the cold, diabolical heart of a bloodthirsty editor. He to highlight.

decides to make the following changes. 2. Press SHIFT and
the appropriate

Follow along with our story and make the changes on your own computer. arrow key(s) to
highlight the text.
1. Move the cursor to the beginning of the confession. Mouse
1. Point to the
2. Highlight To whom it may concern: beginning of the
text you want to
highlight.
3. Select Bold from the Text Menu. i
2. Drag the cursor
e . : . . until you highlight
The text you highlighted now appears in a different color or intensity. sty
3. Release the button,
Iif your printer supports boldface, the text you highlighted will also

appear boldfaced when printed.

Now insert a word.

1. Move the cursor to the ¢ in committed.
2. Typewillfully.

3. Press the space bar.



Spell Checker

Even if you were the
school's Spelling Bee
champion, you'll
appreciate DeskMate's
Spell Checker
accessory. You may
not be able to type as
well as you can
spell-Spell Checker
finds typos too!

Hints for Putting
the Finishing
Touches on Your
Document

Make your document
come alive by using
such finishing touches
as boldface or underline.

« To underline, repeat
the procedure for
boldfacing, except
select Underline
rather than Bold from
the Text Menu.

e Select Plain from the
Text Menu to return
boldfaced or under-
lined text to plain text.

18 D E
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Luke is a perfectionist and decides to use the Spell
Checker to make sure that every word is correct.

Followthe instructions below to see how Spell
Checker works.

1. Select Proof fromthe Edit Menu.

Adialog box appears showingthe
“unknown" word, the context inwhich it is
used, and some possible replacements.

Ifyou typed Luke's confession correctly,
the message Al1words are correctly
spelled appears. If awordis actually
misspelled, you can choose aword from
the Replacements box or move the cursor
tothe context field and correct the
misspelled word.

2. SelectAccept context to acceptthe word.
3. PressEsctoreturntothe Textscreen.

Satisfied that his confession is complete, Luke
preparesto leave. Then, an evil smirk spreads
across his face and he decides to make one more
change—achange that could befatal to Nellie
Tucket.

Make the following change tothe confession.

1. Movethe cursorto the beginning of
Luke's signature.

2. Highlightthe signature,

3. SelectCut fromthe Edit Menu.

Voilal The condemning signature is erased (But, is it? We'll soonknow...), and Luke flees
fromthe mansion.

Meanwhile, on Death Row for a murder she didn’t commit, Nellie Tucket has only minutes
to prove herinnocence. Sam Clubs (the man Nellie loves) returns to the scene ofthe crime
tosearchforaclue, in hopesthat it will lead himto the real murderer.

Sam enters the gothic structure that was once the home of Nellie’s uncle, Frank Fiend, an
eviland cunning man everyone hated and despised. Sam wanders from room to room,
searching for any clue that will save his sweet Nellie.

With only minutes to spare, Sam attempts to enter a west wing room. But, unlike the other
rooms, hefindsit locked. Hetries every trick inthe book to unlock the door—to no avail.
Then, in desperation, Sam uses a nearby antique umbrella stand to break down the door.
He bursts intothe room and is stopped in his tracks by the message glaring on the
computer screen.

Samis deliriously happy as he reads the confession that will save his Nellie—until he
reachesthe end. Thereis nosignature!!! Allislost! Butwait! Sam remembers reading in
his DeskMate User’s Reference about a special invisible memory buffer that stores text
untilneeded. His handis shaking as he reaches for the computer keys.

Sl TR e T




- Follow the instructions below to help
Nellie.

= e ———— e e R ———

ect Paste from the Edit Menu.

| ke’'sname magically appears. Now,
| Sal ther dilemma. He can'tcartthe

L, to Police Headquarters. He'llhave to

d N ! 1

(Refer to your printer's manual.)
option to tell DeskMate the type ¢
sories chapter in the DeskMate U
2 Printer option.

_ Hints on T
Manipulating Text

Information

e Use SHIFT-DEL to "cut’
selected information
without pulling down
the Edit Menu.

» Select Copy (or use
cTRL-INS) from the Edit
Menu to copy (dupli-
cate) information from
your document to the
clipboard. Then, use
Paste to place it in
another part of your
document.

e The Edit Menu’s Un-
Delete option
reinserts accidentally
deleted information.

T U WS

pictures (from DeskMate's
form letters (using information
1d quickly retrieve or delete

has never been
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Hangman is a word game that has
remained popular for years with young

and old alike. With this computerized
version of Hangman, your family will enjoy
a diversion from work and chores—and
even LEARN in the process!

The screens are self-explanatory, but if
you need help to begin, refer to the
instructions below.

After you select Hangman from the
Programs list box, a dialog box appears.

Define Game

Number of Players
81 92 £33 014
Hords per Game: lﬂ 4ﬂn

To select the number of players,
move the cursor to the appropriate
button. Then, either press the space
bar or click the mouse button to
“push” the button.

To select the number of words per «..
game, move the cursor to the :
appropriate arrow. Then, either press
the space bar or click the mouse
button to increase or decrease the
number.

Choose the number of guesses per
word in the same way you chose th
number of words per game..




| 5. Type the names of the players.
6. Select OK.
The Hangman screen appears.
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In a few moments the word is chosen,
and you're ready to play!

The player whose name appears in the
Current Game box goes first,

Type the letter you want to guess.

If it is one of the letters in the word, the
letter appears in the appropriate box(es)
and the letter is no longer available for
this game.

If it is not one of the letters in the word,
part of the hangman drawing appears
and you are one step closer to being
HANGED!

e B e R LB L

Keep guessing letters until you guess the  If you want to change the game or the

word (YOU'RE PARDONED) or until the players, use the appropriate option on

drawing is complete (YOU'RE HANGED!). the Game Menu or Players Menu. For
more information about the options, see

‘The winner is the player who guesses the  the Hangman chapter of the reference
most words without getting hanged. manual.

" A quick glance at the Scoreboard willtell ~ GOOD LUCK!
you everything you need to know about
‘the score and who's next.

After each game, you'll be asked if you
want to play another game.



DeskMate's accessories are designed to
enhance DeskMate in the same way that
other types of accessories can enhance
your wardrobe; home, or car.

Pull down the Accessory (F10) Menu.

Setup

Spell Checker
Calculator
Phone List
Corkhoard
Honth
Cliphoard
Alarm

Task Switch

“ Let's take a peek inside some

~%, . accessories to get you familiar with the
1& way they work with DeskMate.
¥
g ““L\w' 5
& Setup
iﬁ’ The Setup accessory lets you tell
‘m‘ " DeskMate the way you want it to look and
A, run.
%ﬁ‘éﬁ 1. Select Setup from the Accessory
' 5. Menu.
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July 18, 1948
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Driver namei dnpditee
Line feed filter: OFF
Printer Ponts. 1PT1
Charactens Per Tnchi 1A

As you can see, the Setup screen
offers several options from which you
can choose.

2. For now, select Colors to change the
colors of the screen.

If you're using the keyboard, select Colors
from the Options (F2) Menu, If you have a
mouse, just point at the Colors box and
double click.

M AL T “E
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. Press Esc to return to the Setup

Sel Colors

Hemubar Background ‘ -
~mm>mywﬁ\ T

L Text Foreground

Lass Red Hore
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Change Colors: O Perwanent L' wjrisy
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Calors

Move the cursor, located in the
Palettes list box, down to Text
Foreground.

Notice how the color settings below
the Palettes list box change to reflect
the current color.

Now, move the cursor to the color
settings (Red, Green, Blue, and
Brightness).

If your menitor can detect intensity settings,
you can make your screen colors brighter or
dimmer by adjusting the Brightness
setting.

Experiment with the foreground color
by moving the cursor from color to
color and right and left for lighter or
darker colors. You can also go back
to Text Background to change the
background coler. |

After you have experimented with the
colors for awhile, you can choose
whether you want DeskMate to save
them permanently or only use them
until you exit the program. Choose
either Permanent or Temporary.

screen.

Press ESC again to return to the
previous screen.
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Alarm

Scenario: You're busy using DeskMate's
Worksheet application when you receive
a call from your boss. You are to go to
the conference room at 2:30 for a
meeting.

That's just thirty minutes away! You can't
take a chance that you'll forget, so you. . .

1. Pull down the Accessory Menu and

select Alarm,
Alarn! Su by sl
oee
[ e ¢

OUse in Desidlate only

Olse everyuhere
Quick alarm time: E] Onll O
Message: [ |

(EED

17]18/19 20|21 | 22|23

2. Set Alarm: to Use in DeskMate only.
3. Select Use Sound file.

If your computer does not support sound,
this option is unavailable,

4. Select a soundto use from the Files
list box. (The sound you choose
appears in the Sound to use: box).

5. Atthe Quick alarm time: setting, type:
225

(because you want to give yourself

R A
LR

6. Atthe Message: box, type:
Meeting - conference room
7. Select OK.

The alarm is set, and you can rest
easy. At2:25 p.m. you'll hearthe
sound you chose and the F9
selection on the Menu Bar will blink.

8. Select F9 from the Menu Bar to see
the message.

You can also use Alarm with the Calendar
application to remind you of scheduled
events,

Month

Scenario: You're working in the Text
application, writing a letter to confirm a
week-long seminar during the first week
of next month. You don't know the days
involved.

1. Pull down the Accessory Menu, and
select Month.

aly % | Y

b
10(1111213 |14|15]16

2425(26|27|28|29 38
8? Clrl4P m 89 Ctrlth
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The current month appears.

2. Select the N (Next month) button.
The next consecutive month appears
and you can jot down the days set
aside for the seminar.

3. Select CANCEL or press ESC to exit
Month.

DeskMate’s accessories are quick and
easy to use. Remember, you can use
them from ANY application in DeskMate.

. Referto your DeskMate reference manual

for step-by-step instructions for all of

. . DeskMate's accessories.
; an extra five minutes), andthen ..
. select PM, PR L :




| DESKMATE
CALENDAR

So many things to do?!

With all the chores at home, an active
social life, and committee meetings,
you're certain there’'s no way that you can
remember every commitment.

That's not true anymore. Thanks to
DeskMate Calendar.

You've promised yourself twenty zillion
times that you're going to keep an
organized schedule, and now you have
the opportunity to acccomplish your goal
using Calendar. You can schedule your
valuable time, and when you become
organized you may feel like you've been
granted several more hours in each day.
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Calendar lets you schedule your
appointments, chores, meetings, and
events without the clutter of bulletin
boards and paper calendars. You can
tailor your calendar to include dates of
significance to you, such as birthdays or
anniversaries. You can include daily
reminders—remember that dose of
megavitamins. Schedule events by the
date and time, and Calendar lets you
know if there's a conflict in the schedule.
Your events can even be scheduled to
include an alarm which will alert you
when your engagement is looming.

This article tells you how to start up

Calendar and suggests some interesting
things you can do with it.

To start Calendar, select the Calendar list
box. A monthly calendar (named
PERSONAL) appears.

Jul 12, 1988 443 pn
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Monday Tuesday  Hednesday  Thursday Friday Salurday

The Monthly calendar includes diamond
shapes to indicate holidays and your own
annual occasions.

Planning Ahead Pays Off

You're alone in the office at the end of a
long day. You've just filtered through your
mail and notice the concert ticket for
tomorrow night.

“Great!” you say aloud.

It's a long time between now and
tomorrow night, so you decide to add the
event to your personal calendar.

Scheduling an Event

You can use the Add option on the Event
Menu to add the date of the concert to
your calendar.

1. Select Add from the Event Menu.

A dialog box appears. Today's date
appears at the Event date: prompt.

Add Event

Event date: [l 7-12-1988
start tine: [[__] OanOPmH
[ Jomonm

Description:

End time:

alars []
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Atthe Event date: prompt, type
tomorrow’s date.

If you don't need a record of the event's
Start time: andfor End time:, you can
leave the prompt(s) blank.

Atthe Start time: prompt, type 0800,
the beginning of the symphony
concert.

Choose the PM button.

At the End time: prompt, type 1100,
the time you expect to be home.

Choose the PM button.

At the Description: prompt, type
Sympheny concert.

Select 0K to complete the task.

The event appears on the monthly
calendar as a bar graph, and can be
viewed by displaying the daily calendar
for that date.

The deed complete, you leave the office
and head for home, not realizing that the
last entry you made in your personal
calendar could save your life.

One Month Later...

Just press ALT-N to display next month’s
calendar.

alendar as a Surprise Witness

Two plainclothes police officers enter -
your office to question you about a heist
of a large cache of rare black pearls from
your company's vault. The evidence
implicates you as an accomplice. You are
shocked! It seems to be an open and
shut case—unless you can come up with
an alibi. The police officers ask what you
were doing on the date of the robbery.
You turn to DeskMate's Calendar...

1. To display the schedule you had for
the date of the heist, select Find date
from the Search Menu.

2. Type the date of the heist (which
happens to be the same date you
entered for the symphony concert).

3. Select 0K to complete the task.

4. The monthly calendar for that date
appears.

5. Todisplay the Daily calendar, press
CTRL-D.

Your alibi is established! A couple of
phone calls by the police officers verify
that you did, in fact, attend the concert on
the night that DeskMate says you did.
The police officers apologize for the
interrruption and move on to the next
suspect. You breathe easier! You had
already forgotten about attending the
concert that night, but DeskMate

.~ remembered, and saved the day!




Printing Evidence

If you have a printer, you can easily print
out the “evidence” of your innocence.
You can print Yearly, Monthly, or Daily
calendars using Calendar.

Your DeskMate reference manual
provides detailed information.

A Calendar for All Seasons

From the PERSONAL calendar, you can
add up to 19 calendars using the New
option on the Calendars Menu. You could
make different categories of calendars.
Every member of your immediate family
could have a calendar. Or, you could
have separate calendars for the Mayfest
Committee, the Band Boosters, and
everybody’s favorite, household chores.
You should be able to cover any
miscellaneous activities in twenty
calendars (including PERSONAL)
even if you're from the planet Krypton.

To access the calendars you create, you
use the Open option after accessing
PERSONAL.CAL. A dialog box appears,
listing all the calendars you can open.

Just highlight the calendar name and
select 0K to open your calendar.
CTRL-A
CTRL-INS
= ; | eTRLD

M cTRLM
| cTRLW

| CTRL-Y

ENTER

SHIFT-DEL

SHIFTINS

For Those With Tight Schedules

N CR

~

G We eTa T
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You can use the following accelerator key functions |
to speed up your scheduling.

Add an event

Insert a copied section of text
View a Daily calendar

View a Monthly calendar
View a Weekly calendar
View a Yearly calendar

View an event on which the cursor rests
on a weekly calendar

View a daily calendar for the date on
which the cursor rests on a monthly
calendar

Cut a highlighted section of text without
accessing the Edit Menu

Paste the contents of the clipboardp
without accessing the Edit Menu <

S - =
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DeskMate’s Address Book:

The One That Addresses All Your Needs

When it comes to keeping address
books, there are two kinds of people in
the world: those who make an art of
keeping addresses and those who make
an art of losing them.

Which group do you belong to? The first?
One day, I'm sending out a mass mailing
to our best customers. The next, I'm on the
phone recruiting volunteers for a church
dinner. | guess | keep about a dozen
address lists. Or the second? All | want is
one place where | can find and update all
. my addresses quickly. Whichever group
- you're in, Address Book will suit you
perfectly because it lets you maintain up
to 25 separate address lists—all in one
electronic address book.

~ You can use the application in any way
~that works best for you: adding the
~  addresses to the book as a whole
(without ever grouping them into lists);
adding them to individual lists in the first
place; or adding them to either the book
r a list and then copying them, as
eeded, to other lists. It's all up to you.

his article is designed to help you get
arted adding, deleting, and updating
ddresses anywhere in the book. In
ddition, it provides a preview of some of
e things you can do with your stored

BE s e WA T e e
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ADDRESS BOO
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Checking Out the
Address Book Screen

Start Address Book by selecting the

program name from the desktop. The
Address Book screen appears:

Jul 15,
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Index list box—Provides an index to all
the addresses in the address book or the
current list. The addresses are listed
alphabetically by last name, and you can
view a complete address simply by
selecting the appropriate name from the
box.

& Index f
| |

Member Of list box—Lets you know
which lists the currently displayed
address belongs to.

Birl day

Ami versary B

L lutal enlries B Lurrent Field: litle

e Address Book screen is made of
eral parts in addition to the menu bar:

Title First

Company name:
Hork:

Dates to Remember
Birthday

Anniversary §

Title bar—Lets you know what you're
viewing and working on, either a
particular list or all the addresses in the
book. If you're viewing a particular list,
that list is called the current list.

Address Book - All

‘v Memher Of 4
| |

Status line—Lets you know two things:

« How many addresses are in the current
list (or the entire book)

e Which field you're in

Total ontriest @ Cuvent field: Ttle

Getting the Big Picture:
The Whole Book

When you first start Address Book, the
View Menu's All option is already selected
for you. From this vantage point, you can
store addresses without putting them in
specific lists. You can also use this view
to display any address in the book,
regardless of which lists the address
might be in.

You can immediately begin entering
addresses. Try it:

1. Type a courtesy title such as Mr. in
the first field (Title).

2. Move to the next field either by
pressing TAB or by pointing with a
mouse and clicking.

ol
G/

i

How to Correct
Mistakes

BACKSPACE deletes the
character immediately
preceding the cursor

DEL deletes the
character the cursor is
on

How to Move
Through
the Address Book
Fields

TAB moves the cursor
forward

SHIFT-TAB moves the
cursor backward

6%0 £\ o f
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How to Scroll the
Index List Box to
View an Address

Use the scroll arrows,
use the | and % keys, or
type the first letter of the
last name you're looking
for

How to View a
Single Address List

1. Select By list from
the View Menu.

2. Highlight the list
name in the dialog

box that appears.
3. Select OK.

How to View
All Addresses

Select A11 from the View
Menu.

Finish entermg the remaining address
items in the same way.

You can highlight and type over the
words Birthday and Anniversary if you
want the date fields to remind you of
other special dates. If not, use TAB to skip
the words, leaving them as is.

You can enter addresses in any order

because Address Book automatically
sorts by last name.

Here's a sample of how the address
might look when completed:

itle First Last
r. John Appleseed
88 Orchard Lane

HA
Company name: Seedlings Unlimited

Hork: (555) 555-SEED Home: (555) $55-3133

55555

ates Lo Remember
11-15-1957 Birthday

Anniversary

Send recycled
irthday card

To add another address, select Add from
the Address Menu (Fs). (Or, press CTRL-A,
the accelerator for Add.) As Address Book
presents you with another blank record, it
stores the first address and adds it to the
Index list box.

Because Address Book stores all addresses in the
file Personal.adr, you lose the addresses if you
delete this file. For this reason, you should always
keep a backup copy of the file.

When you finish adding addresses, select
any available option other than an Edit
Menu option. Address Book stores the

address and performs the action you
chose.

To view any address in the book, simply
highlight the appropriate name in the
Index list box.

To delete an address" i
book, display it and seleét Delete from
the Address Menu. (Or, press CTRL-D, the
accelerator for Delete.) When asked if

'you're sure you want to delete the record,

select OK. Notice that the address
disappears from the Index list box.

To change any information in an address,
simply highlight the item you want to
change and type over it. Then, select any
menu option (other than an Edit Menu
option) to "re-add" the changed address.

Zooming In: Lists Within the Book

After awhile, you might want to try your
hand at working with a specific address
list. If so, you can view the Christmas card
list, which is already created for you.
When you view the list, notice that the title
bar changes to indicate that Christmas is
the current list.

Add a few addresses if you wish,
including some new addresses you
haven't put in the book before. When you
view all addresses again, you'll see that
the addresses in the Christmas list are
automatically added to the index for the
entire book.

To create your own lists, such as one for
a church group you're active in, select New
from the List Menu (F4). In the dialog box
that appears, type a list name such as
Church. Then, select 0K. Address Book
creates the list and switches you to it.

To delete an address from a specific list,
select the Address Menu's Delete from
1ist option while viewing the address.
When you select this option, Address
Book displays a box that lists the address
lists. Highlight the address list from which
you want to delete the address. Then,
select OK.

Do not confuse the Delete from list option with the
Delete option. The Delete option removes the
address from all the lists it belongs to (the entire
book).

% 1




Options

By now, you have the gist of Address
Book. Several of the remaining Address
Book options simply help store and view
addresses a little bit faster. For example,
you can:

e Add the displayed address to another
list without leaving the current list

e Find an address or group of addresses
by specifying any string of characters
that appears in them

e Merge all the addresses from another
list into the current list

Preview of Other Address Book

Other menu options let you really put
your stored addresses to work. Using
them, you can:

e Dial a highlighted phone number (if you
have an auto-dial modem)

e Print out mailing labels based on your
addresses

¢ Merge information with Text documents
to print form letters

Your DeskMate reference manual
provides detailed information about all
these tasks.

How Address Book
and Phone List
Work Together

Address Book and the
Phone List accessory
access the same

| information. Therefore,
| you can find any

Address Book phone
number from anywhere
in DeskMate simply by
using Phone List.
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Have you ever drawn a picture, and later wished that
your lines were straighter? Or, that a caption had
bolder letters? Or, that the whole picture was just a
little bit smaller?

If you draw with a pencil and paper, all of this can be
a problem. But if you use Draw, corrections can be
very simple.

Let's make a greeting card, so that you can see how
much fun computer art can be! Follow the directions
in this article, but please feel free to experiment with
the tools and patterns. You don’'t need to be an artist
to render this greeting card, or any other
graphics—your creativity is what makes Draw work.

The Birthday Card

Uncle Wilbur is 83 years old. He's had just about
every kind of greeting card ever thought of—gag
cards, serious cards, jumbo cards, and even
electronic jingle cards. The one kind of card he's
never had, though, is a computer-generated birthday
card.

Using Draw

When you select Draw from the desktop, an empty
canvas appears. To the left of the canvas are your
tools. (Select them one at a time.) Above the canvas
is the Menu Bar.

Jul 18, 1988 2:P9 pm

F. Actions -

(Untitled)

Draw -
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The Zoom (F5) Menu contains options that allow you

to back away so that you can get a view of your whole {
canvas, and options that allow you to zoom in on a

small area. (You are currently looking at the upper left

quarter of the canvas.)

1. Select Half or Quarter from the Zoom Menu to
get the big picture.

2. Select Two times or Four times to magnify your
work.

Jul 12, 1988
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Save Often!

Another useful menu option is Save. Save is on the File Menu.
Draw works best when you save often, because changes stored in
memory can easily be lost in a power failure, and can also

increase the complexity of the task for your computer. For more
information about the Save option and other options, see the Draw %
M chapter in your DeskMate User's Reference.




Drawing the Card’s Cover
Let’s Draw a Birthday Cake
1. Todraw the cake, select the rectangle tool.

2. Move to the canvas and indicate the upper left
corner of the cake.

3. Stretch the rectangle by pulling it down and to
the right.

Let’s Draw a Candle

Using the same tool and the same technique, draw a
candle on the cake.

Let’s Draw a Plate

Using the same tool and the same technique, draw
the plate under the cake.

|

dlLet’s Draw Balloons

aw the balloons, select the circle tool.

Move to the canvas and indicate the center of the
circle.

3. Stretch the circle to the desired size.

Let’s Do Some Painting

1. Select the paintbrush tool.

2. Select the Brush option from the Options (Fs)
Menu.

3. Adjust the brush settings to the brush type you
want to use.

4. Decorate the cake by changing brushes and
brush strokes.

5. Using the same tool and the same technigue, "tie"
strings onto the balloons.

Flipping the Picture

Since you plan to fold the printed page into a card,
the cover should be upside down.

1. Select Select all from the Edit Menu. Your entire
picture is highlighted.

2. Select Flip vertical from the Actions Menu. You
see your picture upside down.




Writing the Card’s Message 6. Select Exit from the Options menu. After

ressing ENTER, you return to the canvas.
1. Move to the lower right quarter of the canvas by i d Y

using the arrows on the Menu Bar. You can 7. Be sure your printer is ready to print. Check
zoom away, if it helps you work with the card connections and paper supply. See your printer
more easily. owner’s manual for more information.

2. Select Text from the Options Menu so that you 8. Select Print from the File Menu.
can select a typeface and alignment.

) ; A dialog box appears.
3. Select Roman Medium with center alignment.

4. Return to the canvas. Type: 9. Select Printer: atthe Print to: prompt.
Happy 10. Draw prints the canvas.
Then, press ENTER. Folding the Card

5. Type: Fold the card like this:
Birthday

Then, press ENTER.

6. Type: e

Uncle Wilbur

Then, press ENTER.

e e

You can select any of these three rows of type, and

position them exactly where you want them on the
canvas. =

Printing the Card i

If you have a dot matrix or laser printer, you can print
Uncle Wilbur’s birthday card.

1. Select Setup from the Accessories (F10) Menu. Your card is now finished. You can make cards for the
whole family by simply selecting Uncle Wilbur's name,
2. Select Printer from the Options Menu. deleting it, and typing another. Of course, you can
make all kinds of cards once you learn how to use all
3. Choose the printer name that matches your the tools. In fact, once you know how to use all the
printer the closest. tools, greeting cards will be only a small part of the

things you'll be able to do with Draw.
4. Be sure to select the appropriate printer port

(LPT1, LPT2, or LPT3). If you have only one
printer, use LPT1. See the Accessories chapter in
your DeskMate User’s Reference for more
information.

5. Select 0K when you're finished.




PC-Link

The affordable, easy-to-use on-line service designed especially for DeskMate users!
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PC-Link...

An affordable, easy-to-use on-line service that brings

e Education
e News and information
e Tandy computing support

right into your own home!

It’s right there, on your DeskMate desktop.
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PC-Link is a service mark of Quantum Computer Services, Inc.

Grolier Academic American Encyclopedia is a trademark of Grolier
Electronic Publishing, Inc.

EAAsy Sabre is a registered service mark of American Airlines.
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PC-Link can do so much
for you and your family!

» Get personalized computing help directly from
Radio Shack.

e Learn shortcuts and hot tips to make computing
easier.

« Follow the latest news, stock quotes, weather, and
sports.

e Locate information using an on-line encyclopedia
that's updated regularly.

e Shop in an on-line store, and have your purchases
delivered to your door.

PC-Link is easy to use.

The simple software takes only minutes to master.
Since there are no difficult commands to remember,
you and your family will spend time enjoying the
service—not learning how to use it.

Try PC-Link for one month—free!

We're so sure that you're going to like PC-Link that
your first month of membership is free. That's
unlimited access to a wide array of useful and exciting
services.

Take a free tour of
PC-Link RIGHT NOW!

You can take a free tour of PC-Link right
now. From the DeskMate desktop, select
PCLINK. The Sign On screen appears.
Select 0K when asked if you want to run the
demo. Then, sit back and see a
demonstration of some of the services
PC-Link has to offer.
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Look at how much PC-Link offers you...

Get personalized
computing help directly
from Radio Shack.

Radio Shack hardware and
software people will answer
your questions—fast and

on-line.
Educate yourself and your family. Make smart financial decisions.
Locate information in seconds using an Get individual stock quotes and
on-line encyclopedia that's updated four accurate, timely information to manage
times a year! PC-Link has the entire, your investment portfolio. A

20-volume Grolier Academic 7
American Encyclopedia™
and quizzes to test your
knowledge—all on-line!

Get fast, friendly help.

Receive PC-Link’s monthly magazine FREE. PC-Link’s on-line Customer Service department makes it

As a PC-Link member, you'll receive a free subscription to easy to enjoy PC-Link. Whe_ther you need help getting
PC-Link Update, your monthly guide to all the exciting events around PC-Link, or are looking for a schedule of events, head
on line. for the Customer Service area for fast, friendly help.



Get the scoop on software before you buy.

Make informed purchasing decisions with the
accurate, insightful reviews you'll find_ ==
in PC-Link’s Software Buyer's g

Guide.

Stay informed on today’s top news.

Read the top news, weather, and sports stories, compiled
from the dispatches of eight of the world's largest news wires,
summarized and updated throughout the day.

Save time and money
shopping on-line.
Plan a personal or business
trip and find the lowest fares
by making airline, hotel, and
car arrangements with
American Airline’s EAAsy
Sabre® travel service. Shop
on-line, order on-line, and
have your purchases
delivered right to your door!
PC-Link is the quick,
convenient, and inexpensive
way to shop from your own
home.

Keep up with the
entertainment world.

Get the scoop on all

the news, reviews, and

gossip surrounding your

favorite TV shows,
movies, rock music, and
soap operas—updated
daily. You can even check
your daily horoscope!
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A modem makes it all happen.

All you need to bring these exciting services into your
home and to your family is a modem.

A modem is a device that connects your computer to
your telephone and allows you to "call' PC-Link.
Modems are inexpensive, easy to install, easy to use,
and available from your Radio Shack store.

You'll need to install your modem before you can sign
onto PC-Link. If you're unsure of how to install your
modem, we'll do it for you. For more information
about modems, see "Of Mice and Modems® later in
this guide.

Try PC-Link Plus — FREE!

If you sign up for PC-Link now, you can try the
premium PC-Link Plus services free.

PC-Link Plus is a premium, pay-as-you-go service
that allows you exclusive access to additional
educational and entertaining services. PC-Link Plus
is available only to PC-Link members.

Attend live conferences with experts on subjects
ranging from computing to baseball. Get tips from
Tandy hardware and software experts. Learn tips
and hints on using commercial software programs
from the publishers themselves. Meet other PC
owners from around the country. Shop for bargains
in a 250,000-item on-line store. Send flowers to a
special friend. Have a tutor help your child with
on-line homework. Join a club. Access public
domain software. The list is almost endless.




Let’s Get Linked!

Just follow these simple steps to sign on and try out
your free month of PC-Link membership.

_ Get Ready...
To get ready to sign on for the first time, you need:
e A Tandy (or Hayes-compatible) modem

e A VISA, MasterCard, or personal checking account
number

e Your access telephone number (in the PC-Link
Connect Guide)

Select and Verify Your Telephone

Access Number...

Use the PC-Link Connect Guide to find your access
telephone number. If your city is not listed, check
adjacent areas. Be sure to verify that the telephone
number is a local call. If you do not use a local
number, your telephone company will charge you for
the call, as if it were a long-distance "voice" call.

When a Pause Is Required...

If you're using a Tandy modem, type a P to insert a

brief pause into the dialing sequence (for example, if
l you need to obtain an outside line after entering "9").
t A sample phone number looks like this: 9P5551212.

If you're using a Halyes® or Hayes-compatible
modem, type a comma (,) to insert a pause.

To Dial on a Rotary (Pulse) Telephone Line...

If you're using a Tandy modem, you must tell your
modem to rotary dial by entering the letter “R” directly
in front of the access number (for example, R5551212 ).

If you're using a Hayes or Hayes-compatible modem,
. enter the letter “P” directly in front of the access
| number.

Get Set...

Now you're ready to enter some
preliminary information so that your
computer can connect to the PC-Link

service.

1.From the DeskMate desktop, select PCLINK. The
Sign On screen appears.
lul 17, 1988 11:44 an

PC-Link Help -
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2.Select Set Telephone Info from the Set PC-Link
Info Menu.

A dialog box appears.

Set Telephone Info -1

Hoden Speed 308 1208 02408

See your PC-Link Conmect Guide
for access nunbers

Network O Telenel Tymnet OManual
Phone mumber ISE 2%

1 Second Choice

O Telenet OTymnet OHanual

o
s @D

Netlwork

Phane nunmber
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3. At the Modem Speed prompt, choose the button
that indicates your modem’s baud rate. (See
your modem manual for this information.)

4.At the Network prompt, choose the type of
network you are using to place your call. (The
PC-Link Connect Guide, included in the box with
your computer, gives you this information.)

5.At the Phone number prompt, type the access
phone number.

6.If more than one access number is available for
your area, repeat Steps 4 and 5 for the second
number.

7.Select 0K to complete the task.

8.0pen the Set PC-Link Info Menu again, and select
Set Modem Info.

A dialog box appears.

Set Modem Inf

Select the 0K button to set your
modem information in the DeskMate
Setup Accessory (same as F18@).

| CANCEL

9.Select 0K,
10.Select Communications from the Options Menu.

A dialog box appears.

Setup Communications

Communications port: I,/1 Mouse
o2
Connection: ©J)Modem @ Direct

Hodens L) Hodem name:

HAYES INTERNAL 12688

PLUS 1208

INTERNAL 1260
PLUS 38B-HAYES

42 B E 8 X M A T E

Need help? The call’s on us.

If you have any questions about any of these
connection steps, just call a PC-Link Customer
Relations Representative at 1-800-458-8532.
Someone is waiting to help you!

11.At the Communications port: prompt, choose 1 or
2. If your modem is connected to a built-in serial
port, choose 1,

If your modem is connected to any internal
device (a serial board or a modem board),
choose 2.

If you are using an internal device, be sure that the
communications setting is the same as the setting on the
device's board,

12.At the Connection: prompt, choose Modem.

13.At the Modems list box, highlight the modem you
are using. The name appears at the Modem name:
prompt,

14.Select 0K to complete the task.

15.Select Exi t from the Options Menu to return to
the PC-Link Sign On screen.



Go!

Now you're ready to become a PC-Link member.
From the Sign On screen, open the Sign On Menu.

Then, select Sign On. See the progress of the call on
your screen?

(o 1984 1222 PC-Lin Help
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Comnecling

UVerifying Disk

# Call Progress |

Because this is your first time signing on, a
registration form will appear on your screen. Find
your Registration Certificate—it's in the PC-Link
Connect Guide. Enter your Registration Number and

Password exactly as they appear on the Registration
Certificate.

you to:

e Enter your name, address, and telephone number
with area code.

e Enter your preferred method of payment. (If you
choose to have the payment withdrawn from your
checking account, you'll need to enter your bank
transit number. That's the nine-digit number that
usually appears along the bottom of your check,
just in front of your account number.)

e Select your screen name. (Use your imagination.)

e Answer a brief survey.

You will move through a series of screens that will ask

Once you have completed the registration process,
you will automatically be signed off so that a PC-Link
Customer Relations Representative can call you to
verify your account information. Be sure to turn off
your modem and computer and reconnect your
telephone so that you can receive the call. You will
be called within 24 hours and, in most cases, within
30 minutes.

While you're waiting for the call, feel free to restart your computer and
use DeskMate's other applications and accessories.

Signing on as a PC-Link member

Once you receive that phone call, you are a PC-Link
member. Now you've got a whole month to explore
PC-Link for free. Let’s get started...

From the DeskMate desktop, select PCLINK. Be sure
your modem is turned on and ready to use.

Then, select Sign 0On from the Sign On Menu. The
screen shows you the progress of the connect
procedure. When the connect procedure is
complete, the Main Menu screen appears. That's all
there is to it!
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Explore PC-Link...

Now that you're signed onto PC-Link, take some time
to explore.

From the Main Menu screen, open the PC-Link Menu
and select Customer Service.

PC-Link F4
Tandy Headquarters

Sof tware Buyer's Guide
NewsLink Headl ines
Dollars & Cents
Reference Desk
Entertainnent Guide
Our Horld
Quiz Center
Home Shopping

More Questions About PC-Link?

If you have more questions about PC-Link, use the
Ask PC-Link area in the Customer Service
department. You'll get a prompt and helpful
response within 48 hours.

If you need more help after joining PC-Link, call
(703) 448-9660.

@
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To find out what's going on tonight on PC-Link, select
Tonight's Best Bets. Then, select the On-Line
Members' Guide for descriptions of each feature in
PC-Link and shortcuts and hints for getting around
the system. When you are finished browsing through
Customer Service, simply press Esc, and move on to
another PC-Link department. Take your time, and
have fun!

See you on line...

There are challenging things to do and interesting
people to meet on PC-Link. Now that you are a
member, visit PC-Link often to find out what's going
on.




| Have you been meaning to develop a

(| budget, balance your checkbook, or
prepare a loan amortization plan? With
Worksheet, DeskMate’s electronic spread-

sheet program, you can do all these things
and more!

Worksheet will make organizing your per-
sonal finances simple. This article explains

, | some of the basics of Worksheet and

{| guides you through a handy example, creat-
ing a home budget.

DIE S KMATE
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Using Worksheet

When you select Worksheet from the desktop, an
empty worksheet appears. A worksheet is divided
into numbered rows and columns. The area where a
row and column intersect is called a cell. Cells are
identified by row and column numbers. For example,
the first cell in the upper left corner (highlighted
when you open a worksheet) is referenced as R1C1.
A cell's default size is 10 characters.

(Untitled)

Scrolling Arrows

DESKMATE

Status Line |
Shows typ
lighted by tﬁg

percentage of memory
used.
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Let’s begin our sample home budget with a title. To
enter this text, do the following:

1. Highlight cells R2C3 and R2C4.
2. Select Start text from the Cells Menu.
3. Type: HOME BUDGET,

4. Select End text from the Cells Menu.

Jul 18, 1988 11:48 an Horksheet - (Untitled) Help F

[PadFigSearchigiCelisiy (413 einl
4 5 6 7

Z 3

HOHE BUDGET

1
2
3
4
i
6
T
8
)
(]
1

27 Full LABEL NUMBER INPUT  FORMULA

You can enter labels to identify your worksheets’
categories.

To enter the first [abel in Column 1 of our example,
highlight Cell ROC1 and type GROCERIES. Enter the rest
of the labels in the example. Note that the labels
automatically align to the left. Then, enter the labels in
Row 7 for Columns 2 and 3.

In the example below, BUDGETED and ACTUAL are right
aligned. If you want to right align these labels on your screen,
refer to "Format Cells” in the Worksheet chapter of the DeskMate
User’s Reference to find out how.

Jul 18, 1988 11:44 am Horksheet - (Untitled)

1 Z k| 4 3 b

HOWE BUDGET

00 =3 O LA B N

BUDGETED ACTUAL

9 GROCERIES
18 CLOTHES

TEXT NUMBER INPUT  FORMULA

48 DESKMATE

Typing errors can be corrected by backspacing and retyping.
For more information, see "Correct an Error' in the Worksheet
chapter of the DeskMate reference manual.

Now you are ready to enter the numbers. To enter a
number, highlight the appropriate cell and type the
number. As you type the numbers in our example,
notice that decimal points are automatically inserted if
you don'’t insert them. (For example, if you type 125
the screen shows 125.00.) Numbers are also
automatically aligned to the right.

Jul 18, 1998 11:52 an Horksheet - (Untitled) Help Fy

griitEpadrafsearchgliailsy  T#[¢ el
1 2 3 4 5 6 7

HOME BUDGET

1
2
3
4
B
6
T
8

9 GROCERIES

BUDGETED  ACTUAL
250. 088
158.98 129.31
28, 728.

65,58 6Z. 34

87. 68 64.19
145,98 145.P0

6. oo

217.17

2z Full LABEL  TEXT WL [HPUT  FORMULA

Now you're ready to tell Worksheet what calculations
you want done. To do so, you enter formulas where
you want the results of the calculations to appear.

To enter the first formula in our example, do the
following:

1. Highlight Cell R19C2.
2. Then, select Formula from the Cells Menu.
A dialog box appears.

3. Type the formula SUM(#R8) and select 0K.

Jul 16, 1988 12:16 pn Horksheet - (Untitled) Help F,

T I — 3 02
z 3 4 5 6 7 '

HOME BUDGET

BUDGETED  ACIUAL

0 -3 O U I N

9 GROCERIES
18 CLOTHES 158.98  129.31
11 HORTGAGE 720.08 720.00
12 ELECTRIC 65,58 62,34

250.08  Z217.17

 Fornula Row 19 Col 2

(Emm ]

Forsula

Operators @ ¢, -, & /, 1
Functions: ABS, ATM, AUG, CHT, COS, EXP, [T, LOG, HAX, HIN, RHT, SGN, SIN, SQR, SUN, TAN
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Then, enter these formulas.

In Cell: Type Formula:
R17C3 MIN(#R8)

R18C3 MAX (#R8)

R19C3 SUM(#R8) - (#R17+R18)

The formulas do not appear in the cells, but when the
cells are highlighted the formula can be seen in the
status line. Different formulas can be entered in other
cells to yield additional results.

For more information, see "Create a Formula® in the Worksheet
chapter of the DeskMate reference manual for details.

Select Calculate from the Pad Menu.

The results of the calculations are displayed in the
cells that contain the formulas.

Jul 18, 1988 12:18 pn Horksheet - (Untitled) Help Fy

T — ) (02
3 4 5 e g ]

HONE BUDGET

BUDGETED  ACTUAL

1
2
3
4
5
]
T
8

9 GROCERIES 258.08  217.17
150.98  129.31

TZ0.08  720.890

65.58 | 62.34

07. 08 64.19

145.98  145.99

68. 88 6P. 68

60. B8
120,
1477. SR UEL NI

2z Full LABEL  TEXT NUMBER

SUR (SRB) - (SR1T+R18)

To exit Worksheet, select Exit from the File Menu. A
dialog box appears.

Save changes?

Select YES to save changes.

Then, another dialog box appears. Type a file title
(such as BUDGET) of eight characters or fewer.

Save as.

C: \DESK

L SHE

Select Save to complete the task.

The screen displays the desktop.

You can add rows, columns, and blocks of text to your

worksheet to handle additional items and amounts.
See the DeskMate reference manual for details.
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From attendance records to zucchini recipes, from auto repair costs to zoom lens replacement costs, you
can keep track of all kinds of information when you get organized with ...

ILER

The Filer application is an all-purpose tool for
storing and retrieving information. With it, you can
quickly locate and update your favorite recipes,
medical records, video and audio tape libraries,
sports statistics, household inventories, club
membership lists, records of tax-deductible
contributions—just about any kind of information
you can imagine.

Filer is very easy to use. You simply open a Filer
file and then add records, which you can think of as
electronic "index cards." Each time you add a
record, the application stores it in the file
automatically.

This article uses the sample file, Invntory.fil, to
quickly guide you through Filer's basic operation.
Then, it explains how to create your own Filer files.

S ——
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Getting Into Filer

Ifthe Filer list box does not appear onthe
desktop when youfirst start DeskMate, you
can accessthe application by selecting
FILER.PDMfrom the Programs list box.

Whenyou select FILER.PDM, an Open File
dialog box appears. Atthe Open File:
prompt, select INVNTORY . FIL and then 0K to
open Invntory.fil.

Using the Sample File

Invntory.filis designed to help you maintain
ahome inventory for insurance purposes.
Whenyou openthefile, you see its first
record.

Therecord is divided into several fields,
areas where you store specific items of
information.

This sample file contains three records. To
viewthe nextrecord, press CTRL-N oruse
amousetoclick onthe Next button (lower
right corner of screen).

Now, add anew recordto thefile;

1. Select Add from the Records Menu
(F4). A new, blank record appears.

2. Type the item for the first field (ROBOT).

3. Move to the next field by pressing
TAB or by pointing with a mouse and
clicking.

Finish entering the remaining items inthe
same way.,

Jul 9, 1988 11:41 am

Filer - C:\DESKNINUNTORY. FIL Help Fy

I T |

99. 95 1-3616 je500 |

Realistic STA-2780 AH/FN stereo digital receiver with
ireless remote control. Search mode, memory for storing
ix A and six FN stations, digital fluorescent display, !

bhuilt-in tape control center for two-way dubbing and

two-deck monitoring.

Invntory.fil's First Record

The Filer Menus

l_l—"ﬂ
L1 - Contains options for manipulating entire files, such as Open
to open a file.
il Fal - ; ‘ . ;
M — Contains options for changing record information.
Records Fy

to add a record.

— Contains options manipulating entire records, such as Add

frocor N\

9‘!.95 $8-2197 1143888

Robie Jr. Remole Control Robot with ultrasonic remote
control. Speaks nine phrases. NMoves forward, backuard,
left, and righl. Has wovable arns and removable Lray.
Requires one 9V and four "I" balleries.

New Record to Add

How to Display a
Record

CTRL-F displays the first
record

CTRL-N displays the next
record

CTRL-P displays the
previous record

CTRL-L displays the last
record

You can also use the
corresponding
Records Menu options.
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How to Move
Through Fields in
a Filer Record

TAB moves the highlight
forward

SHIFT-TAB moves the
highlight backward

How to Correct
Mistakes

BACKSPACE deletes the
character immediately
preceding the cursor

DELETE deletes the
character the cursor
is on

The price ofthe robotis incorrect. To
changeit, simply highlight the field and
typethe new amount ($79.95).

519, 95; 60-2197 11/38/88

Robie Jr. Remole Conlrol Robot wilh ultrasonic remole |
ontrol. Speaks nine phrases. Hoves forward, backward, l
left, and right. Has movable arms and removable tray.
equires one 9U and lour "D” hatteries.

2\ 7/

Ifyou'd like to use Invntory.fil for your own
belongings, you'llwantto delete the
sample records. Todelete arecord:

1. Display the record.

2. Select Delete from the Records Menu.

3. Select 0K.

Afteryou addrecords inyourfile, you can
usethe Print record option on the File Menu
tomake a hard copy on paper of eitherthe
record currently displayed or allthe
recordsinthefile. Youcan also print a
report about your records, using the Print
report option.
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Creating Your Own Files

Tocreate otherfiles, allyou dois copy
Invntory.fil's layout.

Here’s how to copy Invntory.fil's layout:
1. Open Invntory.fil.

2. Select Copy layouts from the File
Menu. The screen displays the
Copy to: prompt.

3. Type afilename of eight or fewer
characters for the new file. For
example, type Carwork to create
Carworlk.fil.

4, Select 0K Filer creates the new file,
but you are still in Invntory.fil.

5. Use the File Menu's Open option to
open the new file so that you can use
it.

Thppetizers/Dip

TDill Dip

1 cup real mayonnaise
\1 cup  Sour Tlreau?
{ inced onion
.:;ried Aill weed (not seed)
parsley flakes
. seasoned salt
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Tips and Techniques for
Further Organizing

Nowthat you've had a sampling of
what Filer will let you do, you might want
to explore some of its possibilities. Go
ahead. You can:

» Alphabetize (sort) records by field.

s Find a group of records that meet
specific criteria you set (for example, all
inventory items valued at more than
$200).

» Get a count of the records in your file.
and even...

e Use the Form Setup application to
design your own record layouts.

Your DeskMate reference manual provides
detailed information about all Filer and
Form Setup tasks. In addition, if you're
eagerto create your ownrecord layouts,
you can read about howto dothisinthe
Form Setup article.

Sorting Records

Invntory fil is sorted by
the first field (inventory
item name). If you don't
have a sort order, Filer
sorts from oldest entries
to newest entries.
Therefore, each time
you add or change a
record, that record goes
to the end of the file.







Question: What do you get when you
cross a Filer application with a Farm
. Setup application?

Answer: A Flexible Filer!

A very flexible Filer, in fact, because with
Form Setup you create the files yourself,
from "scratch." This means that you
control every aspect of your file layouts.
To begin with, you control the size and
location of the information fields. (Notice
how youican keep track of something as
detailed as baseball statistics!)

earteR  Baith, C. Positions
Position {1(_ = pilcher
e T I - valcher
Opposing Tean Scorpions = 1sL base
=S 2 = 2nd base
Dale Wi/12/88 = 3rd base
b shortstup
= left ficld
A Bats F Hits = center field
= pight field
RBls 1] Ruirs - pimch hiller
h = designaled hitter

But, there’s even more. For example, you
can assign field labels to later remind you
which information item to enter in each
field. You can even include graphics from
Draw in your layouts!

To see the relationship between Filer and
Form Setup, open a file (such as
Inuntory.fil) in Filer. Display any record.
Then, switch to Form Setup by selecting
Form setup from the File Menu (F2).

Notice that the Form Setup menus
replacegthe Filer menus. You are still in
che file, but now you are looking at its
o o

——

record layout. Here is Invntory.fil's record
layout:

Jul 9, 1988 12:46 pm Form Setup - C:“DESKNINUNTORY. FIL
[File = EdiLF. Recurd %, Repurt = [Ficld -,

Creating a New File

Still in Form Setup, select New from the
File Menu to create a new file. When
prompted, specify a filename of eight or
fewer characters for the new file (such as
Medical for Medical fil). Then, select OK.
The application opens the file and
displays the cursor on an otherwise
empty work area. This is where you will
create the file’s record layout.

For example, if you wanted your file's
records to look like this:

FANILY MEDICAL DXPEMSES - 1988

1o S )

Dr. Date Date Insurance Filed

Exan:
Lab Hork:

Hedicines:

Total Charges: ; fwount Covered: § .88
You would create this record layout:

FAILY MEDICAL EXPENSES - 1988

paion (MRS 1t (EIITD
Or. [TTTTTITTTIIIINND. ate TITITIC  Bate Insuramce Fited (TTTTIIT]

Exan: BT il
Lah Hork:
Hedicimes: i

Total Charges: STITHT

fmount Covered: [TTTIIT)

The Record Menu'’s Define option, which
lets you create the record layout, is
already selected. All you have to do is

| S ~=—pegin adding fields.
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How to Select Add
Quickly

Double-click the
mouse button or press
ENTER.

How to Add
Character Slots

Moving the cursor
down and up adds and
deletes whole rows of
character slots. Moving
the cursor right and left
adds and deletes
whole columns. Every
tenth slot is shaded to
aid you in counting.

You might want to create Medical.fil by
: following these steps:

i

Use the arrow keys or mouse to
position the cursor where you want

the first field (not the field label) to

appear. Then, select Add from the
Field Menu (Fe).

Exact positioning of the fields isn't
| important. You'll learn later how to
highlight fields so that you can move
them.

The field's-f&éi-chakéc’ter slot appears
on the screen.

2. Add character slots until the field is

the desired size.

i e s .
Here's how: With the keyboard, press
— as needed and then press ENTER.
With a mouse, position the pointer on
the cursor andgrag it; then, release
the mouse button.

3 A dialog box appears so that you can

specify the field attributes. For
example, for the first field, specify the
attributes shown here. Then, select OK.

= Data Field Definition 5

[[PATIENT |

Name:

Outlined: EBDyes Klno
Data type! €3 text EKnumber
Label: €3left D)top £ hidden

LCANCEL ]

L3

4. Repeat Steps 1-3 to add each of the

\

remaining fields. Follow these ©
guidelines:

3

o Select number as the data type for
fields in which you will enter dallar

' amounts. Select text as the data
type for all other fields.

e Select yes or no for outlining as
indicated by the art.

Insert the dollar sign ($) and decimal
point (.) format characters in the'
amount fields.

Here's how: Highlight the field, and
then select Format from the Field
Menu (Fe). Then, type the format J
characters in the appropriate slots
and press ENTER.

Format characters are optional. Kl
However, you must include a decimal

point in any numeric field in which you

plan to enter decimal characters.

Otherwise, Filer lets you enter only

whole numbers. 5
r
" ) !
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6. Add the cosmetic text (FAMILY
MEDICAL EXPENSES-1988).

Here's how: Move the cursor to
where you want the text to begin.
Then, type the text and press ENTER.

The horizontal lines on the Medical fil
layout are also cosmetic text blocks. You
can create them by repeatedly pressing
the underline key (SHIFT-hyphen).

To erase or move a field or a block of
cosmetic type, highlight the item. Then,
use the appropriate Edit Menu option(s).

You can copy cosmetic text and graphics using
the Cut and Paste options. However, you cannot
copy a field because each field can appear only
once on a layout.

Once you finish creating a record layout
in Form Setup, you can immediately
return to Filer to begin adding records. To
do so, select Filer from the File Menu

(F2)..

When typing information in the numeric fields, you
must type a period or press — to move the cursor
tothe right of the decimal point. Then, you cantype
over the two zeroes.

\

Tips and Techniques
for Creating File Layouts

You can save time by designing
layouts before creating them in
Form Setup. Be sure to leave
enough room for field labels and
outlining, if desired.

gln addition to deleting and moving
a field, you can change its size and
attributes (using the Field Menu's
Size and Change options). Be
careful, though, when performing
any of these operations. If you
delete a field in which you have
already entered information in
Filer, the information is lost.

(=4

BWhen designing your fields, take
into account the kind of
information you might want to
obtain from a report about the file.

For example, suppose you wanted
Medical.fil's report to list a specific
patient’s total charges per visit,
followed by that person’s total charges
for the year. The record layout would
have to include Patient and Total
Charges fields. In addition, you would
need to use Filer's Sort option to limit
the report to the one patient.

For information on creating report
layouts so that you can print reports,
see the Form Setup chapter of the
DeskMate reference manual.

5 If you want to have some extra
fun—and improve the appearance
~of your layouts at the same
time—try including some graphics
from Draw! (To print graphics, you
need either a dot matrix printer or
a laser printer.)

Use the Edit Menu's Copy and Paste
options to transfer borders, special
type, and pictures from Draw to your
layouts. '

FAMILY MEDICAL EXPENSES

Patient
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How to Decide on
the Data Type

Use numeric fields for
information you might
perform calculations
on. Numeric fields
allow you to enter only
the characters 0-9 and
+ or - (indicating
whether the number is
positive or negative).
Use text fields for all
other information—
including dates.

How to Correct
Mistakes

If you make a mistake
when specifying a
field's attributes, you
can select CANCEL to
begin again. You can
also highlight a field
and then use:

o[he Edit Menu's Clear
option to delete it.

eThe Field Menu's
Change option to
change it.

To highlight, use the
arrow keys to position
the cursor anywhere
on the field; then,
press the space bar.
Or, use a mouse to
click on the field.

Use BACKSPACE or
DELETE to erase
individual characters,
including format
characters.

C i




Have you been meaning to communicate with an 3. Select the appropriate additional commands and
information service, send that special computer game their sequence according to the host's

to your friend, or just keep in contact? With your requirements.

computer and Telecom, you can do all of these things
easily. If you are communicating over the telephone,
you also need a modem. User’s Reference.

A sample autolog file is shown below. For more
information, see the individual commands in the DeskMate

Telecom makes communicating with another system
simple by enabling you to build and save an autolog

automatic log-on (“connection”) file. 4. Select Buffer on from the Buffer Menu if you want
to save data sent by the host system.
When you select Telecom from the desktop, an
empty Command screen appears. The screen is 5. Select Execute from the Commands Menu to
divided into two columns, commands and parameters. execute the new file.
Let’s begin our sample autolog file. 6. When you finish, you can disconnect by returning
to the command screen using ALT-C. Then, use
1. Select Set from the Commands Menu. the Disconnect option on the Options Menu.
At the various prompts, choose the option that Jul 9, 1988  4:44 pn Telecom - C: \DESKMTELHAG. LOG Help Fy
the host computer (the computer you want to [File fdCommands = iBuffer FylOptions®s | tFL!
communicate with) requires and that is o
compatible with the capabilities of your modem. biiia ! il
(See the instructions that come with your Rl s O DU
modem.) If you are connected directly to another Send | Break-Sequence
computer, continue with Step 3. e R L
2. Select Call from the Commands Menu. G oyt
At the Phone number: prompt, enter the host's ‘#‘l.ﬁJZ: Tllensne", . b, 20 ssconds
telephone number (up to 30 digits). If you have an -
autodial modem, the number is dialed
automatically when the file is executed. For other
modems, you must manually dial the host's
telephone number just before execution of the
autolog file.
i
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- MS-DOS, The Basics

Question:
Answer:
Question:
Answer:

If you plan to primarily run
applications from DeskMate,
you don't need to know
anything about MS-DOS. But
as you begin to feel
comfortable with your computer
and computer programs, you'll
find that you'll want to know
something about it. And, within
reason, the more you know, the
more you can do with your
computer.

\ Dr. David A. Lien is the author
of these books — a gifted
educator and writer.,

MS-DOS, The Basics is a short, easy-to-read book on
the basics. In this book, the author gives you a short
and simple introduction to computers and then starts
talking about MS-DOS, the operating system for
Tandy’s current line of personal computers, as well
as all other PC-compatibles.

One of the distinctives of Dr Lien's style of writing is

that everything is practical — you try it all out. It's an
“interactive” book. So, you learn by doing.

Also, Dr. Lien has a rather personable, humorous way
of writing. You'll find yourself enjoying his style. The
book is organized into three simple sections.

- Startup to shutdown
- Using MS-DOS to prepare diskettes
- Using MS-DOS to manage files

In the first section, you get into date and time,
directories, and printing. In the second section, you
learn a great deal about disks (and disk drives). Then
you use some of the common commands —
formatting, copying, backing up, comparing disks,
and checking disks. The last section is more
complex, dealing with managing files.

Fortunately, with DeskMate many of these MS-DOS
functions are handled in simple graphic ways right
from the desktop. But for those of you who want to

If you want to know more about computers and how to get the most out of yours, we'd like
to recommend a couple of books ...

- MS-DOS, Advanced Applications
And just what is MS-DOS ?

MS-DOS is your Microsoft Disk Operating System.
Do you need to know what MS-DOS is? |

It depends on what you want to do with your computer.

know more, we highly recommend this book. We'd
particularly recommend at least skimming through
the first two sections. (That’s just 75 pages.)

MS-DOS, Advanced Applications is for the person
who wants to become fairly proficient with MS-DOS.
It's a longer book (over 350 pages) that covers a lot
of material in considerable detail. This volume
continues in the author’s practical learn-by-doing
style.

Subjects covered include:

- An introduction to MS-DOS

- Working with files

- Organization

- Batch files

- Personalizing and maintaining your system

... and some fairly technical details.

The author provides summaries at the end of each
chapter. Dr Lien also gives a number of practical
suggestions gained from his own experience. You'll
find this book extremely helpful.

Stop by your Radio Shack store and look for both of
these MS-DOS books, as well as our other interesting
and helpful books.

D E § K' M A T E 59



A S
A 5%
:

&

-

N

e,

Two of the most popular add-ons for
computers are the mouse and the
modem. A mouse is a natural
enhancement to the DeskMate
environment. A modem and software
such as PC-Link and Telecom add a

Yl
g i

7\ TN
v

ﬁm whole new dimension to your computing,
&,,’:] communicating with other computers.
| Understanding a few basic concepts

oL
WU

about serial devices will help make setting

up your modem and/or your serial mouse
a lot easier.

There are many different kinds of serial

L T mice and modems with different types of

,(:',{@3 features, but they are all connected to

& the computer in one of two ways:

® External serial devices are devices that
e w

are outside of the computer and are
connected to a serial port on the back
of your computer. Some computers
already have a serial port built in.
External devices include serial mice and
external modems.

.'.:“.‘ :
.-‘)

" %nternal serial devices are boards you
‘= install inside your computer just like any
other option card. If your computer
does not have a built-in serial port,
'_~. you will need to install a serial
4 board to use an external
- — device. Serial boards and
internal modem boards are
available for most

—
\ }_ | computers.

The thing to remember about
serial devices is that many
computers and most
software permit you to have
only two serial devices.
When you install a serial
device you must do two
| things:

+'Set up the communication
settings on any internal
hardware .

(The Fundamentals of Serial De\;ices)

-/Set up the communication settings in
your software.

These settings tell the computer which
device will use Communications Port 1
and which device will use Commun-
ications Port 2. These ports are often
referred to as Com1 and Com2.

Establishing the settings for the hardware
usually involves setting dip switches or
jumpers on option cards (your internal
modem board and/or serial board). You
will need to consult the manual that came
with your option card to see how to set
these switches for Com1 or Com2.

Establishing the settings in your software
usually involves answering prompts about
which device uses which port. In
DeskMate, use the Mouse Settings and
Communications Settings options in the
Setup accessory.

The If...Then... Rules

If you are installing these devices
yourself, be sure to have the manuals that
came with your computer and your
devices handy.

If you are connecting only one serial
device, be sure the hardware and
software settings are set for Com1.

If you are connecting two serial devices,
be sure the settings you make in your
software match the settings you make for
your hardware. Most software programs
assume you will use a modem at Com1
because most modems are set at the
factory for Com1. However, you can
change both hardware and software to
Com2 if Com1 is already in use.

If your computer has a built-in serial port,
it is already set up to be Com1. Therefore,
if you have a device connected to the
built-in serial port and add an internal



modem board or a serial board for a

second port, you need to set up the
option card to be Com 2.

Picture This

The following illustrations show some of
the most common computer and serial
device configurations.

Computer with a Mouse Connected to a
Built-in Serial Port

Computer with a Mouse Connected to a
Built-in Serial Port and an Internal
Modem Board Installed

Computer with an External Modem
Connected to a Built-in Serial Port

Computer with a Mouse Connected to an
Internal Serial Board and an External
Modem Installed
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Helpful answers to some commonly asked questions
about DeskMate.

Which printers can | use with DeskMate?

You can use a dot matrix, daisy wheel, or laser
printer to print information from DeskMate’s
applications. To print illustrations from Draw, you
need an IBMPRO or IBMGRAPHICS (or compatible)
dot matrix printer or an HP Laserjet‘R (or compatible)
laser printer. The Setup accessory’s Printer option
provides a list of the printers supported by
DeskMate. See the Accessories chapter in your
DeskMate User's Reference for more information.

Which pointing devices can | use with DeskMate?

You can use a pointing device such as Tandy's

Serial Mouse (or any other Microsoft-compatible
mouse).

What are programs?

Programs are files that tell your computer how to do
tasks, such as displaying the characters you type,
drawing graphics on your screen, calculating, and
so on. DeskMate’s large programs are called

applications; DeskMate’s small programs are called
accessories.

What are data files?

Data files are collections of related data. A picture
created with DeskMate's Draw, a letter written with
DeskMate's Text, or a budget created with
DeskMate's Worksheet can each be saved on a disk
as a data file. For instance, if you are using Text to
write a letter to Mary, you supply a name for the file
(Dearmary, for example). Text automatically supplies
the extension .doc. The complete filename,
Dearmary.doc, then appears in Text's list box on the
desktop. See the Text article in this guide or the Text
chapter in the reference manual for more information.

Can | format a diskette without leaving DeskMate?

Use the Format option on the Disk Menu to format a
diskette without leaving DeskMate. You'll be
prompted to enter information about the drive and
your diskette. Then, you just select 0K and follow the
prompts on the screen. See the Desktop chapter in
the reference manual for complete instructions on
formatting diskettes.

How do | copy a disk?

Use the Diskcopy option on the Disk Menu to make
one or more copies of a diskette. You'll be prompted
to enter information about the drives you're copying
from and to. Then, you just select 0K to begin the
copy procedure. See the Desktop chapter in the
reference manual for complete instructions on
copying disks.

How do | copy a file?

Use the Copy option on the File Menu to copy a file to
any directory on any disk. You'll be prompted to
enter information about the file you're copying. Then,
you just select 0K to complete the procedure. (See
the Desktop chapter in your reference manual for
complete instructions on copying files.)

Why are some menu and dialog box options
shadowed?

When menu options or dialog box options are
shadowed, that means that they can't be chosen. An
option appears shadowed because some other
setting is in effect, so the option does not apply.
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accelerator keys, for Calendar application, 27
accessories
Alarm, 23
definition, 9
Month, 9, 23
Setup, 9, 22-23
Spell Checker, 18
Address Book application
changing addresses, 30
correcting mistakes, 29
deleting addresses, 30
entering addresses, 28-30
index list box, 29
lists within the book, 30
member of list box, 29
moving through, 29
other options, 31
records and fields in, 29
screen for, 29
scrolling addresses, 30
status line, 29
title bar for, 29
uses for, 28
Alarm accessory
setting, for the Calendar application, 26
using, 23
applications. See also names of

specific applications, such as Text application.

applications

definition, 9

opening, 8, 9

starting from list boxes, 9

starting from program list boxes, 11
autolog files, for Telecom application, 58

Cc

Calculator accessory, 9
Calendar application
accelerator keys for, 27
adding events, 25-26
displaying the daily calendar, 26
multiple calendars, 27
overview, 24
printing the calendar, 27
setting alarms, 26
starting, 25
switching calendars, 26
uses for, 25
cells. See Workshest application.
colors of the screen, changing, 22
columns. See Worksheet application.
communications, setting up, 42
configuration. See setting up.
copying
diskettes, 62
files, 62
cosmetic text, 56

D

data files, definition, 62
databases. See Filer application.
databases, on-line. See PC-Link application.
date and time, changing, 10
DeskMate

overview, 1

uses for, 12
desktop

getting around in, 8

illustration, 7

running, on diskette-based systems, 8
dialog box

exiting, 10

illustration, 10

shadowed options on, 62

diskette-based computers
running the desktop on, 8
starting DeskMate on, 5
swapping diskettes, 11
diskettes
copying, 62
formatting, 62
Draw application
canvas for, 32
drawing and painting procedures, 33
overview, 32
printing drawings, 34
saving drawings, 32
text in drawings, 34
Draw application
zooming a drawing, 32

E
exiting DeskMate, 6

F

fields. See Address Book application; Filer application;
Form Setup application.
Filer application. See also Form Setup application.
adding records, 51
correcting errors, 52
creating new files, 52
deleting records, 52
displaying records, 51
illustrations, 51
menus for, 51
moving through fields, 52
starting, 51
switching to Form Setup application, 55
tips and techniques, 53
uses for, 50
files
autolog files, 58
copying, 62
creating
in Filer application, 52
in Form Setup application, 55
data files, 62
Form Setup application. See also Filer application.
adding fields, 55-56
character slots, 55
Form Setup application
correcting errors, 56
cosmetic text, 56
creating new files, 55
data types, 56
entering text in numeric fields, 56
erasing and moving fields, 56
format characters, 56
switching to Filer application, 55
tips and techniques, 57
formatting diskettes, 62
formulas. See Worksheet application.

G

games. See Hangman.

graphical interface, definition, 1
graphics, drawing. See Draw application.
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Hangman serial devices
dialog box for, 20 internal and external, 60
playing the game, 20-21 setting up, 60-61
screen for, 21 setting up

han.:l-dlskl systems communications, 42
installing DeskMate on, 6 mouse, 14

starting DeskMate on, & serial devices, 60-61

help | Setup accessory, 9, 22-23
DeskMate crib sheet, 65 Spell Checker accessory, 18
getting help, 8

spreadsheet. See Worksheet application.
starting DeskMate
on diskette-based computers, 5
I on hard-disk systems, 6
on Tandy 1000 SL and 1000 TL computers, 5

for PC-Link, 43
quick reference, 11

installation, for hard-disk systems, 6

T
L Telecom application. See also PC-Link.
layout for records and reports. autolog files for, 58
See Form Setup application. uses for, 58
list boxes, 8 Text application
program list box, 11 changing text in, 17
starting applications from, 9 checking spelling in, 18
correcting errors, 17
M cutting and pasting text, 18-19
menus exiting, 9
accessing, 9 highlighting blocks of text, 17
definition, 9 opening, 9
opening, 8 printing text, 19
selecting options on, 8 screen for, 9, 16
shadowed menus, 62 typing in, 17
modem time and date, changing, 10
definition, 40
serial boards and, 60 w
Month accessory. See also Calendar application. Worksheet application
opening, 9 calculating formulas, 49
using, 23 cell references, 47
mouse columns, 47
compatibility with DeskMate, 62 correcting errors, 48
overview, 13 exiting, 49
serial mice, 60 formulas in, 48-49
setting up, 14 illustration, 47
using, 15 labels, entering, 48
numbers, entering, 48
P rows, 47
painting. See Draw application. saving, 49
PC-Link. See also Telecom application. size of cells, 47

definition, 40

exploring PC-Link, 44

free tour of, 37, 40

getting help with, 43

illustration, 36

modem for, 40

requirements for, 41

setting up communications, 42

signing on, 43

starting PC-Link, 41-42

uses for, 37, 38-39
Phone List accessory, 31
pointing devices. See mouse.
printers, using with DeskMate, 62
program list box, 11
programs, definition, 62

Q

quick reference, 11

record and report layout. See Form Setup application.

records. See Address Book application; Filer application;
Form Seiup application.

rows. See Worksheet application.



DeskMate Crib Sheet

Use this handy listing to look up the DeskMate Basics, and always remember that from
anywhere in DeskMate:

F1 = Help

ESC|| _

= "Never mind!" and/or "Go back
to the last screen."

Press this:
fii2i

END

HOME

CTRL- | OF PGDN

CTRL- | O PGUP

Keyboard Basics

To move the cursor:

In the direction you choose
To the end of the line

To the beginning of the line
To the bottom of the screen

To the top of the screen

Mouse Basics

To Point: Move the mouse until the tip of the pointer
is where you want it.
To Click: Quickly press and release the left button.

To Double Click:

To Drag:

To SHIFT Click:

Click the left mouse button twice in rapid
succession.

Hold down the left button while moving
the mouse.

Hold down the sHIFT key and click the left

CTRL-HOME To the beginning of the file

CTRL-END To the last line of the file

CTRL-N To the next page of the file

CTRL-P To the previous page of the file

TAB To the next section of a dialog box or
the next list box on the desktop

SHIFT TAB

To the previous section of a dialog box
or the previous list box on the desktop

mouse button.
Click on this: To move the cursor:
To the right
To the left

Down

[» f« [¥] 3]

up

Using Menus (Keyboard)

1. Press the appropriate function key to open a menu.
2. Press | until you highlight the choice you want.

3. Press ENTER to make the selection.

Using Dialog Boxes (Keyboard)

1. Use 1AB to move to the section of the dialog box where
you want to make a change.

2. Type new information in blanks.

3. Use the arrow keys to move the cursor within a group
of buttons or checkboxes. When the cursor is resting
on your choice, press the space bar.

4. When everything in the dialog box is the way you want
it, select the 0K button, or press ENTER to complete the
dialog, and begin the operation.

or

Select the CANCEL button or press Esc to cancel the

dialog and exit the dialog box without making any
changes.

Using Menus (Mouse)
1. Point to the appropriate menu.

2. Drag the highlight to the choice you want to select.
3. Release the button to make the selection.

Using Dialog Boxes (Mouse)

1. Point to the blank you want to fill or the choice you
want to select.

2. Click the button.
3. |If it was a blank you picked, type the new information.

4. When everything in the dialog box is the way you want
it, click on the 0K button to complete the dialog and
begin the operation.

or

Click on the CANCEL button to cancel the dialog and
exit the dialog box without making any changes.




Desk\Vlate

Getting Started

Easy-to-use DeskMate is a graphics-oriented software package with popular features like pull-down
menus and dialog boxes. DeskMate comes with a variety of practical application programs that let

you write, organize, budget, schedule events, and much more. And, because the same technigues
are used throughout, DeskMate is simple to learn. For even easier operation, you can add a mouse
for "point and click" convenience.

With DeskMate software you can:

J Turn out letters and reports in a jiffy with the Text word processing

program. Then use the Spell Checker to proof the job.

‘/ Play Hangman, just like when you were a kid.

J Chat live with PC owners across the country. Pose questions to

leading software publishers. Access on-line encyclopedias, news

stories, stock quotes, and much more with PC-Link and a modem.

\/ With Filer and Form Setup, create a personal database to keep

track of recipes, household inventories, repair costs, your video
tape library, and such.

J Keep track of your family, friends, customers, organizations, or

even your Christmas card list with our electronic Address Book.

‘/ Use Calendar to remind you of appointments, birthdays, and

meetings. Can't afford to be late? Use the Alarm.

\/ Draw pictures for ads, cards, or just for fun. Transfer your art to

another program like Text to illustrate reports or essays.

« Balance your budget or even develop a loan schedule with

Worksheet, the DeskMate spreadsheet program.

Communicate with other computers directly or with a modem using

Telecom.
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And there’s much much more! The DeskMate desktop can be customized for your personal uses
and allows you to run applications written by other software publishers as well. Use DeskMate on any
PC-compatible computer with 384K, CGAA, EGA, and Hercules, or VGA Video support.
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